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9Creating and Organizing Tasks 

Introduction

Just as Microsoft Office Outlook 2003 has streamlined and
updated the capability to track messages, contacts, and the cal-
endar, it has also transformed the humble to-do list into a mar-
vel of organization and efficiency. The Outlook Tasks folder
allows you to generate digital to-do lists, as well as track the
tasks involved in the completion of a project. 

In this chapter, you'll enter tasks, add details to them, mark
them as complete, and delete them. You can sort and organize
tasks through the use of folders and categories, and you can
even assign tasks to others.

Outlook's Task feature provides an efficient vehicle for organ-
izing and managing the things you need to do on a daily,
weekly, monthly, or yearly basis. 

What You’ll Do

View the Tasks Folder

Create and Update Tasks

Change Task Views

Sort Tasks

Organize Tasks

Manage Your Tasks

Prioritize Tasks

Assign Tasks to Others

Monitor Task Progress

Customize Your Tasks Folder

Share Task Information with Others
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Clicking the Tasks button in the Navigation pane displays the contents of
the Tasks folder. You can view these contents in several formats, but the
default mode is the Simple List view. This view displays the tasks in a list
with columns for the item type (a task), a check box to indicate whether
the task is done, the task subject (a short description of the task), and the
due date. For more information about a task, you can double-click it. The
Task dialog box features two tabs, Task and Details. Most of the details
from the Tasks folder appear on the Task tab; the Details tab contains
boxes for adding information about the details you encounter when per-
forming tasks.

Viewing the Tasks
Folder

View the Tasks Folder and 
a Task

Click the Tasks button on the
Navigation pane.

Click the Simple List option.

Double-click a task. 

Click the Task or Details tab to
view information about the task.

Click Close.5

4

3

2

1

See Also
See "Changing Tasks Views” on 
page 174 and "Sorting Tasks” on page
175 for more information on viewing
tasks.

2

1

Short
description 
of task

4

5

3
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To create a task, you click the New Task button on the Standard toolbar.
A new Task dialog box opens. Type the Subject, which is the text of the
task. This text appears in the Subject column in the Tasks folder. You can
also set a Due Date (the date by which the task must be completed),
Start Date, the Priority (Low, Normal, or High), and you can check the
Reminder check box to have a reminder window open the morning of the
due date. To keep track of the task, you can set the Status (Not Started,
In Progress, Completed, Waiting On Someone Else, or Deferred) and the
Percentage Complete (0 to 100%). You can type additional information
about the task in the notes area at the bottom of the window.

Creating and 
Updating Tasks

Create or Update a Task

In Tasks view, click the New Task
button on the Standard toolbar or
double-click the task.

Type a short description of the
task in the Subject box.

Click the Due Date list arrow, and
then click the due date. 

Click the Start Date list arrow, and
then select the start date.

Click the Status list arrow, and
then click an option.

Select the percentage in the %
Complete box, and then type a
new percentage. 

Click in the Notes area, and then
type additional information about
the task.

Click the Save And Close button.8

7

6

5

4

3

2

1
8 2 3

5
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You can display tasks in a variety of views. The default Simple List view
displays the task's description, the due date, and a check box to indicate
that the task is completed. To see more information about each task, you
can switch to Detailed List view, which includes columns for the task's
priority, whether a file is attached, the status of the task, the percentage
complete, and the category of each task. Detailed List view does not
include the column with the check box to indicate that a task is com-
pleted (although in both views, completed tasks are indicated with
strikethrough text). To show all your tasks in order by due date, you can
switch to Task Timeline view to see a horizontal timeline with tasks noted
on their due dates.

Changing Tasks 
Views

Change Tasks Views

Click the Tasks button on the
Navigation pane.

You can change the Tasks view in
several ways. 

◆ Click the View menu, point to
Arrange By, point to Current
View, and then click By
Category. 

◆ Click the Detailed List option in
the Navigation pane.

◆ Click the Next Seven Days
option in the Navigation pane.

◆ Click the Task Timeline option in
the Navigation pane.

◆ Click the Simple List option in
the Navigation pane.

2

1

Task
Timeline

Did You Know?
You can hide tasks in a grouped view.
Hide tasks in grouped views (By
Category and By Person Responsible)
by clicking the minus sign to the left of
the group name. When you do this, the
tasks collapse under the group header
and the minus sign changes to a plus
sign. To display the tasks in that group
again, click the plus sign to the left of
the group name.

2

1
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Sorting Tasks

Sort Tasks by Field

Click the Customize Current View
link in the Navigation pane (scroll
down if necessary), and then click
the Sort button.

TIMESAVER Right-click a
blank area of the Tasks folder
window, and then click Sort on the
shortcut menu.

Click the Sort Items By list arrow,
and then click the desired sort
field.

Click the Ascending or Descending
option in the Sort Items By area.

TIMESAVER Click a column
head in any view except Task
Timeline to sort in ascending order
by that column; click the column
head again to resort in descending
order.

To add a secondary sort field, click
the first Then By list arrow, select
the desired sort field, and then
click the Ascending or Descending
option.

TIMESAVER Press and hold
the Shift key, and then click a
second column head in any view
except Task Timeline.

Click OK.5

4

3

2

1

Outlook allows you to sort tasks in any view and by any field, either in
ascending order (A to Z) or descending order (Z to A). You can sort tasks
by a specific field, or by a column header appearing at the top of the
view's table (Subject, Due Date, Status, and so on). When sorted in a
view, the tasks maintain the same view, but their order has changed. It's
also possible to generate multilayered sorts within a sort by adding more
fields to the sort. The second field fine-tunes the search by introducing a
second criterion. If you sort tasks in a view, the column used for sorting
and the sort order are indicated in the view by a small triangle in the 
column heading.

2

4

View sort in 
this column in
ascending order

3

5

OL03S-3-4
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As with other types of items in Outlook, you can use folders and cate-
gories—keywords or phrases associated with an Outlook item—to
organize tasks. For example, if you are a supervisor, you can keep sepa-
rate folders for each employee's key tasks or you can categorize tasks
according to the projects you are working on. To organize your tasks
using folders, you can use the Ways To Organize Tasks pane or you can
drag the task to the folder in the Navigation pane. You can assign a cate-
gory to a task in the Tasks folder or by using the Ways To Organize Tasks
pane. You can select from one of the built-in categories, or you can
define a new category to suit your needs.

Organizing Tasks

Organize Tasks with Folders 

Click the Tools menu, and then
click Organize.

Click the Using Folders tab in the
Ways To Organize pane.

Click the New Folder button.

TIMESAVER Click the New
button list arrow on the Standard
toolbar, and then click Folder.

Type the new folder name.

Click Tasks in the Select Where To
Place The Folder list.

Click OK.

Click the Move Task list arrow, and
then click the folder name to
which you want to move the task.

Click the Move button.

TIMESAVER Drag the task to
the folder name in the Navigation
pane.

Click the Close button in the Ways
To Organize task pane.

9

8

7

6

5

4

3

2

1

4

5

New folder name
appears here 2 8 3

9

7

6
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Organize Tasks with Categories

Click a task in the Tasks folder to
select it, click the Tools menu, and
then click Organize. 

Click the Using Categories tab in
the Ways To Organize pane.

Type a new category name.

Click the Create button.

Click the Add Tasks list arrow, and
then click a category name.

Click the Add button.

Click the Close button in the Ways
To Organize task pane.

TIMESAVER Right-click the
task, and then click Categories on
the shortcut menu.

7

6

5

4

3

2

1

See Also
See "Customizing Your Tasks Folder" on
page 184 for more information about
changing the way the Tasks folder
looks. 

2 5 7

6

4

3
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As you work with tasks, you'll want to keep your Tasks folder updated to
reflect the status of each task. One obvious tactic is to mark each task
as completed once you've finished the task. To do this, you open the
Task dialog box and then change the Status box to Completed or the %
Complete box to 100%. Once you've marked a task as complete, it
appears in the Tasks folder with a line through it. Some tasks are jobs
that you need to complete on a regular basis. For example, you might
need to submit a monthly report to a supervisor. You can make a task a
recurring task by clicking the Recurrence button on the Standard toolbar.
Recurring tasks have a small icon with two circling arrows in the Tasks
folder.

Managing Your Tasks 

Mark a Task as Completed

Double-click the task.

Click the Status list arrow, and
then click Completed.

TIMESAVER In views with a
Status column, click the Status
column for the task, click the list
arrow, and then click Completed.

Click the Save And Close button.

TIMESAVER In Simple List
view, click the Complete check
box.

3

2

1

1

Completed look

2

3
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Change a Task to Recurring

Double-click the task.

Click the Recurrence button on the
Standard toolbar.

Click to select a Recurrence
Pattern: Daily, Weekly, Monthly, or
Yearly.

Click to select other Recurrence
options.

Click the appropriate end date in
the Range Of Recurrence area.

Click OK.

Click the Save And Close button.7

6

5

4

3

2

1

3

4

5

6

2

7
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If you have a long list of tasks, it is important to prioritize them, so that
you finish the most important ones first. You can assign a priority of High,
Medium, or Low to each task. The priority appears in a column with an
exclamation point heading in all views, except for the Simple List view. A
High priority task has a red exclamation point as the priority indicator;
Normal priority has no indicator; and Low priority has a downward-point-
ing blue arrow. As you plan your day, it is a good idea to schedule time to
complete certain tasks. You can drag a task from the Tasks folder to the
Calendar, and then set start and end times for the task. The task appears
in your calendar as an appointment. Finally, you might not want to keep a
list of every task that you have completed, or you might need to delete an
active task.

Prioritizing Tasks

Prioritize a Task

Double-click a task.

Click the Priority list arrow, and
then select a priority.

Click the Save And Close button.3

2

1

Did You Know?
You can record the amount of time you
spend working on a task. Click the
Tasks button on the Navigation pane,
double-click a task, click the Details
tab, and then type the number of hours
you worked in the Actual Work box.

You can delete a task. Click the task
you want to delete, and then click the
Delete button on the Standard toolbar.

High priority

Low
priority

3

2

1

Normal priority
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Schedule Time in Calendar for 
a Task

Drag a task from the Tasks folder
onto the Calendar button on the
Navigation pane.

Set Start and End days and times
in the Appointment dialog box that
opens.

Click the Save And Close button.3

2

1

3

Task subject

2
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Because most projects involve the efforts and input of several people, it
will often be necessary to delegate responsibilities for a task to other
members on your team of contacts. In Outlook, you can assign and send
a task assignment to a co-worker. To assign a task, you open the Task
dialog box, click the Assign Task button, and then assign the task to
someone in your Contacts list. If a task is assigned to you, you will
receive an e-mail that contains the task request. You can accept or
decline the task, and send your reply back to the sender.

Assigning Tasks to
Others

Assign a Task

Double-click the task or create a
task.

Click the Assign Task button on the
Standard toolbar.

Click the To button, select a
recipient, click the To button, and
then click OK.

Click the Send button.

Accept or Decline a Task

Open the task request.

Click the Accept button or the
Decline button.

To reply to the sender with a
comment, click the Edit The
Response Before Sending option,
click OK, type a comment, and
then click the Send button on the
Standard toolbar.

To send the response without
comment, click the Send The
Response Now button on the
Standard toolbar.

4

3

2

1

4

3

2

1
4

Assign Task button toggles to
Cancel Assignment

3

OL03S-1-6, OL03S-2-4

2
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After you've passed along ownership of a task, you will want to keep
track of it. Whenever it's edited, you'll want to check the changes, just
as you will need to know any supplemental information about the task
and stay up to date on its status. Outlook enables you to automatically
keep track of assigned tasks and receive regular updates on their
progress. When you create a task, you are designated as the owner of
that task. As its owner, you are the only person who can edit the task,
unless you assign it to someone else and they accept the assignment. In
that case, however, you can still opt to maintain an updated copy in your
Tasks folder and obtain status updates whenever the task is edited or
completed.

Monitoring Task
Progress

Receive Updates for an
Assigned Task

Double-click the task.

Click the To button, select a
recipient, click To, and then click
OK.

If it is not already selected, select
the Keep An Updated Copy Of This
Task On My Task List check box.

If it is not already selected, select
the Send Me A Status Report
When This Task Is Complete check
box.

Click the Send button.

Click the Assignment option on the
Navigation pane.

6

5

4

3

2

1

5

2

3

4

Owner 
of  task

6

OL03S-1-6, OL03S-2-4

Did You Know?
You can cancel a task assignment. In
Tasks view, double-click the task, and
then click the Cancel Assignment 
button on the Standard toolbar.

You can arrange the tasks to view all
the tasks you have assigned. In Tasks
view, click the View menu, point to
Arrange By, point to Current View, and
then click Assignment.
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You can customize the Tasks folder to suit your working style. For exam-
ple, you can change the default colors of overdue and completed tasks
from red and gray to any other available color. To do this, click the Tools
menu, click Options, and then click the Task Options button. You can also
customize task reminders. In the Options dialog box, you can change the
time that a reminder window opens for a task. The default time is 8:00,
the start of the default work day in Calendar. You can also modify the
task options so that reminders do not appear for tasks with due dates.
You do this in the Task Options dialog box.

184

Customizing Your
Tasks Folder

Customize the Default Colors in
the Tasks Folder

Click the Tools menu, and then
click Options

Click Task Options.

Click the Overdue Task Color list
arrow, and then select a color.

Click the Completed Task Color list
arrow, and then select a color.

Click OK.

Click OK.6

5

4

3

2

1

See Also
See "Organizing Tasks" on page 176 for
more information about changing the
way you view the Tasks folder.

3

4

5

2

6
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Customize Task Reminders

Click the Tools menu, and then
click Options.

Click the Reminder Time list arrow,
and then click the time that you
want a reminder window to open.

Click Task Options.

Select or clear the Set Reminders
On Tasks With Due Dates check
box to use or not use reminders.

Click OK.

Click OK.6

5

4

3

2

1
2

3

6

54
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If you are working on a project with a group, you might need to share
information about tasks with other members of the group. You can send
a task to someone else without actually assigning it to that person. To do
this, open the Task dialog box, click the Actions menu, and then click
Forward. A new e-mail message window opens with the task as an
attachment. 

Sharing Task
Information with
Others

Share Task Information with
Others

Double-click a task.

Click the Actions menu, and then
click Forward.

TIMESAVER Right-click a task
in the Tasks folder, and then click
Forward on the shortcut menu.

Click the To button, select a
recipient, click To, and then click
OK.

Click the Send button.4

3

2

1

Did You Know?
You can attach more than one task to
an e-mail message. You can attach
more than one task to an e-mail mes-
sage by dragging a new task from the
Tasks folder onto the Message win-
dow. The task will appear as a second
attachment in the Attach box.

You can make a task private. To make
a task private, click the Tasks button
on the Navigation pane, double-click a
task, and then click the Private check
box.

See Also
See "Assigning Tasks to Others" on
page 182 for more information about
assigning tasks to someone else.

4

Task as
forwarded
subject

Task as
attachment

3
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